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Verktyg

Modern programutveckling innebar att man maste beharska ett
antal verktyg

e Editorer

e Kompilatorer

e Avlusare (debugger)

e VVersionhantering (kommer i projektkurs)

e Testverktyg (kommer i projektkurs)

e \Verktyg for analys av kodkomplexitet, kodkvalite,

kodeffektivitet, m.m.
°...

Vi skall titta pa Eclipse, Findbugs och STAN
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Eclipse

En (ett?) IDE (integrated development environment)

Ett mycket avancerat ramverk. Kan anvandas for manga olika
sorters programmering (och manga olika sprak)

e Uppbyggt med "plugins”

e Finns massor av plugins, enkelt att installera direkt fran natet

Innehaller editor, debugger, m.m.
Ger mycket hjalp med trivial kod, fixa

irriterande smafel, struktur, ...,
maste dock tanka sjalv!
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Eclipse Versioner

Finns tyvarr valdigt manga, forvirrande... En gang varje ar slapps en s.k.
“simultaneous release” som bildar bas for andra versioner som inriktar sig pa
olika omraden. En sadan release namngiven efter en astronomisk foreteelse
eller person, senaste heter Eclipse Luna:

s eclipse

Tva uppdateringar (SR1 och SR2) gors ocksa varje ar vilket ger tre releaser
per ar, se http://wiki.eclipse.org/Simultaneous_Release

For att fa den senaste och battre prestanda, hamta en egen version istallet
for att kora den som ar forinstallerad pa Chalmers. Ingen installation kravs,
bara att packa upp, i mappen eclipse, kor filen eclipse.
http://www.eclipse.org/downloads/ (valj IDE for Java Developers)
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http://wiki.eclipse.org/Simultaneous_Release
http://www.eclipse.org/downloads/
http://www.eclipse.org/downloads/

SE UPP

Forsta gangen du startar Eclipse fragas eventuellt efter ett
workspace
e Det kommer att skapas en mapp "workspace" i din
hemkatalog
e Svara ja, kryssa for "Inte fraga igen..."
e Du skall ha exakt ett workspace
e Du skall aldrig spara nagot i workspace, anvand en
kursmapp (~/TDAS50 eller dyl)
e Om Eclipse far problem, ta bort workspace-mappen, ger en
ny frash installation
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Eclipse Arbetsflode

1. Skapa projektkatalog, projektkatalogen skall innehalla alla .java-filer
och ovriga resurser programmet behover (ikoner, bilder, ljud, ...)

2. Skapa ett Eclipse projekt med hjalp av t.ex. menyn File->New.
For att inte lagga projektet i ditt workspace, klicka ur “Use default
location”. Du behover da sjalv skapa en ny mapp for projektet och
ange sokvagen i "Location", anvand t.ex. “Browse..."-knappen.
Starkt rekommenderat!

3. Lagg till paket, klasser, bibliotek m.m. m.h.a. Eclipse

4.Koda, kor, avlusa och faktorisera m.h.a. Eclipse

5.i1f( lok ) goto 3

6. Skapa jar-fil (slutgiltiga programmet) m.h.a Eclipse
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Filstruktur for Projekt

Eclipse-projektet skapar en filstruktur i projektkatalogen
myproj.ep // Project dir
--- bin I/ *.class-files. Created by Eclipse at compile

|--- se
|--chalmers

--- SIC // Package hierarchy for *.java-files
|---se // Top level package
|--chalmers
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Eclipse Projekt

Projekt, ett internt begrepp for Eclipse
e Inte samma som projektkatalog
e Kan ta bort projekt i Eclipse utan att radera kod (om du vill kan du
ta bort koden ocksa)
e Kan importera projekt
e Kan skapa projekt utfran "losa" Java-filer
e Kan ha flera projekt oppna samtidigt

For att Eclipse skall acceptera ett projekt maste filerna .project och .
classpath finnas i projektkatalogen, skapa nytt (ev utifran I6sa filer)

En gang till: Inte spara projektet i workspace!
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Eclipse Anvandargranssnitt

Finns valdigt manga fonster... nagra begrepp...
View, ett internt fonster, t.ex. Navigator (filhanteringsfonster)
Editor, ett fonster dar man kan arbeta med text

Perspective, ett visst arrangemang (layout) av ett visst antal

views och editors
e Kan vaxla perspektiv (forvirrande for nyborjaren, fonster forsvinner/dyker
upp byter plats)
e Problem: Markera perspektivet Java (Ikon langt upp hoger, hogerklick
Reset)

Det ovan finns att valja under Window-menyn
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Olika Vyer av Projekt

[ Pack ‘ fs Hiera l‘d: Navi 82 « JuJuni | =8
Méjligt att modifiera vad som . Rkl
visas, View Menu, flat, hierarchical —
(= settings
_ _ _ _ _ _ v (& bin
18 pack 2 Tg Hiera ’ w5 Navi ‘ Ju JUni ’ '=',E|\ b & se . .
o &[N/ v Gy sre (Filhantering)
v oy = calculator.ep [it-002_workshop master] v G se " Kontrollera att
v (&4 chalmers :
v i . ’ rojektets
e | Ni anvinder © Gy hajo Proj .
b 3 se.chalmers.hajo.calc i filstruktur ar
. denna vy v & calc
b 3 se.chalmers.hajo.calc.con b & con korrekt
b #} se.chalmers.hajo.calc.core b L; core (Sténgda
b 3 se.chalmers.hajo.calc.core.state b G ctr projekt visas
: 2se.c:a:mers.:aj.o.ca:c.ctr.l Ni har inte sma b G gui ev har)
1 se.chalmers.hajo.calc.gui . G
. gula cylindrar > Sop
b 3 se.chalmers.hajo.calc.op Git 1} Main java
P (B> test ( | ) P (> test
P =) JRE System Library [JavaSE-1.6] ) .classpath
P =i )Unit 4 Y .project
7% compile.sh (28 compile.sh
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Eclipse Varningar och Felmeddelanden

Eclipse kompilerar kontinuerligt i bakgrunden
Varningar och fel visas | marginalerna

e \anster: lkoner, glodlampor m.m.

e Hoger: Var i filen, rod(a) markering(ar)

Peka pa ikoner for att fa tips, klicka och valj andringsforslag
(Eclipse foreslar,.. dock inte alltid optimalt)

Ibland "hanger" felmeddelandena kvar, spara sa forsvinner de!
e Kan ocksa hjalpa att kora Project > Clean...
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Faktorisering

Faktorisering innebar bl.a.
e Flytta/byta namn, m.m. pa paket, klasser, metoder, variabler
e Andra metodsignaturer
e Bryta ned stora metoder

e Ersatta klasser med interface
o ...

All faktorering skots fran Eclipse (Markera > Hogerklick >

Refactor)
e Eclipse andrar overallt i programmet sa att allt blir korrekt
e Andra aldrig direkt i filsystemet!
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Eclipse Debug

For att avlusa valjer man ... Debug As > Java Application
e Eclipse byter da till debug perspektivet
e Se vidare workshop
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Effektiv Eclipse

Lat Eclipse gora alla rutinjobb
e [mportera
e Formatera (snygga till koden)
o Ctrl + Shift + F
e Faktorisera
e Generara kod
o Generera konstruktorer, set/get-metoder, m.m.
e Kommentera/avkommentera
e TODO lista

Om du behover det sa finns det i Eclipse, leta... (hogerklicka i koden)
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Eclipse Avslojar Proffsen

BREANK

NEWS
Lar av proffsen

e Om man angivit var kallkoden till Javas standardbibliotek
finns (src.zip) kan man direkt granska klasser m.m.

Markera nagot klassnamn, tryck F3

e Otroligt nyttigt och intressant att se "professionell" kod
e Att se hur man implementerat saker okar forstaelsen
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Eclipse Tutorials

Intro for nyborjare
http://eclipsetutorial.sourceforge.net/totalbegginer01/lesson01.html

Debug
http://eclipsetutorial.sourceforge.net/debugger01/lesson01.html
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Eclipse Plugins

Hela Eclipse ar uppbyggt av plugins. Olika versioner av Eclipse innebar egentligen
olika uppsattningar av plugins.

| samma anda gar det att installera extra plugins i den version du anvander. De kan
installeras pa olika satt, ett vanligt ar via menyn
Help > Install New Software > Add

| dialogrutan anges addressen till en “Software (Update) Site” som plugins ska
hamtas fran. Denna behover man kanna till sjalv, t.ex. genom att kopiera adressen
fran en hemsida (se slides FindBugs och STAN). Av erfarenhet kan sagas att manga
“software site adresser” har en tendens att andras sa ga alltid in pa tillverkarens
hemsida for att vara saker pa att fa senaste versionen.

Valj darefter just de plugins som ska installeras, resten skots automatisk, men du
kan uppmanas att godkanna avtal och ev. installation av “unsigned software”.

Eclipse behover normalt startas om efter installationen.

CHALMERS




==l

P I . ] I . d B [£ Package 82 - Navigato
u g I n S u I n u g S 1 calculator.ep o ‘

New >
Co Into

¥ (#src
> i3 se.cha
> .ch,
> gz:zh: Open in New.Window
» fisecha Open Type Hierarchy F4
h,

] > H#3se.cha Show In N #EW >
P =, JRE Syster »
Hemsida | SBRES oy %
2 Copy Qualified Name

http://findbugs.sourceforge.net/ * Paste v

% Delete ®

Remove from Context l
Build Path >

Software site e, =
http://findbugs.cs.umd.edu/eclipse ba mpor..
‘ ugs > “% Find Bugs
. . é’lo':: :Z?ect F5 X Clear Bug Markers L
Ko rn I n g Close Unrelated Projects =], Save XML L
.- . . g Assign Working Sets... [/ Open Analysis Results in Editor
Hogerklicka projektet och valj Debug As | tatoad XML
. . Run As >
Find Bugs > Find Bugs vaiae »
Da 6ppnas ett eget perspektiv med flera egna vyer. Restore from Local Historyo.
Configure >

Properties 81

Syfte

Analyserar koden och listar bade potentiella buggar och andra osakerheter eller best
practices som inte foljts. Det gar att valja vilka analyser som ska genomforas. Mycket
anvandbart!
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f% Package 82 . Navigato O

Plugins: STAN g

- E§ CG)::t:l New Window
Hemsida b o cew
http://stan4j.com/ S

7 Paste EAY

% Delete ®
SOftware Site Bm:{der:;\;e from Context .
http://update.stan4j.com/ide Refactor o
(vélj plugins “STAN IDE” samt “STAN IDE Tools”) =

Find Bugs

>
« Refresh F5
. - Close Project avadoc Declaration Search E Console &3
Ko rn I n g Close Unrelated Projects slay at this time.

Assign Working Sets...

Hogerklicka projektet och valj T T
Run As > Structure Analysis feam R

Compare With

Da 6ppnas ett eget perspektiv med flera egna vyer. Restore from Local History...

Configure

= 4 Structure Analysis...
Run Configurations...

Properties 81

Syfte
Anvands for strukturanalys:
e Beroenden mellan olika delar (paket, klasser etc) kan analyseras och koden kan
utforskas interaktivt.
e Avancerad analys kan goras for att bedoma kodens kvalité.
o Detektion av cykliska beroenden
o Matvarden, t.ex. de framtagna av Robert C. Martin
o FOr den intresserade finns ett white paper pa: http://stan4j.com/papers/stan-
whitepaper.pdf
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Referens: Eclipse Keyboard Shortcuts

Har foljer anvandbara tangentbordskommandon i Eclipse (bara som referens for den intresserade).
Alla shortcuts gar att stalla in via menyn: Preferences->General->Keys

Finns aven forinstallda scheman ex. Emacs.

Notera att de kan skilja sig pa Mac OS (oftast genom att Ctrl byts mot Command).

Debug/Korning

F5 - Stepinto
F6 - Step over
F7 - Step out

F11 - Starta senaste debug
Ctrl + F11 - Starta senaste korning

Navigera mellan vyer/editorer/perspektiv

Ctrl + F6 - Vaxla fil

Ctrl + E - Vaxla fil via filnamn

Ctrl + F7 - Vaxla vy

Ctrl + F8 - Vaxla perspektiv

Alt + Shift + Q, P - Visa/Vaxla till Package Explorer

Texteditor (avser ofta koden dar markoren star)

Hall musen 6ver kod (hover) 6ppnar beskrivning/dokumentation
Ctrl + 1 - Quick fix menyn ("glédlampan")

Ctrl + 3 - Quick access menyn (testal)

Ctrl + Mellanslag - Content assist / Code completion
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Texteditor (avser ofta koden dar markoren star) forts.
Ctrl + f - SOk/Ersatt i aktuell fil

Ctrl + - Inkrementell sOkning i aktuell fil

Ctrl + h - SOk i hela Workspace/Projektet/etc.

Ctrl +1 - Gatill rad

Ctrl + g - Ga till senaste editeringsposition

F3 - Oppna definitionen

F4 - Oppna typhierarkivyn

Ctrl +t - Oppna tillfallig typhierarki

Ctrl + - Vanster musklick Oppna definition (med val)

Ctrl + - Shift + G Lista referenser till kod

Ctrl + - Shift + T Oppna typ via namn

Ctrl + . - Hoppa till nasta kompileringsfel i aktuell fil

Ctrl +/ - Kommentera/Avkommentera markerad kod
Ctrl + Shift + F - Korrigera indentering m.m. (formatera) hela filen
Ctrl +i - Korrigera indentering

Ctrl + Shift + O - Rensa upp i import

Se vidare
http://www.vogella.com/tutorials/EclipseShortcuts/article.html
http://www.shortcutworld.com/en/win/Eclipse.html
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